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              Give a Talk, Eat a Meal  

Gabe Goldberg, PATACS Member 

Two of PATACS' three monthly meetings are 
held at Carlin Hall in Arlington. The monthly 7 
pm first Wednesday gathering features a Q&A 
session, followed by a relatively informal presen-
tation/demo/discussion, followed by heading to 
nearby Mom's Pizzeria for the ñPizza SIG". To 
encourage and reward speakers at these meet-
ings, PATACS buys presenters dinner at Mom's. 
The menu includes many food groups so there's 
something  for everyone's tastes: pizza, subs, sal-
ads, etc. 
 
Presentation/demo/discussion offerings can be 
VERY informal. People have demonstrated fa-
vorite phone/tablet applications, interesting web-
sites,     hardware gadgets, interesting gifts re-
ceived, anything technology/computer related. 
Everyone has a bit of technology that's important 
to them -- and if it's shared, it might just be the 
thing to become someone ELSE's important tech-
nology favorite. So think about what you'd like 
to share with fellow PATACS members and con-
tact PATACS president Paul Howard <plhow-
ard@verizon.net> to schedule sharing. 

Continued Page 2 

Every time I write an article or deliver an edu-

cational presentation, I start by establishing its 

relevance. I try to answer the implied question: 

what about the subject might be useful to you?  

In all the years I have been delivering such tech 

info, including about a decade for the Washing-

ton Area Computer User Group (WAC), a cou-

ple of years for PATACS, and about 3 years of 

professional experience while I was finishing 

my MS in computer science, the one thing I 

learned consistently from those experiences is 

that audiences learn far more rapidly when rele-

vance of the subject matter is established up 

front.In 2018 and early 2019, I contributed a 

series of articles about screen capture tech-

niques to the PATACS Posts newsletter. In the 

first of those articles, I wrote a long series of 

relevance suggestions. Mostly the reasons were 

related to effective meeting presentations; I was 

encouraging readers to become presenters at 

club meetings. A few months later, it occurred 

to me that screen captures can be very useful 

for every one of us (not just presenters): we can 
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Google MUCH More Than Search     

INTERACTIVE, INFORMATIVE                               

AND EXCITING!                                                

3rd Saturday,   June15     1:20 PM                                                                                                 

Better Way to Request Help                    
Asking for help is often fraught with am-

biguities. Here is one way to be              

specific, and accelerate answers.                            
By John Krout, PATACS member 
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web servers usually recover within ten to thirty 

minutes. 

HOW TO CAPTURE DETAILS OF THE ER-

ROR The first time you see a puzzling error 

message           or any puzzling behavior on your 

computer or smart phone or tablet, capture that 

screen image, and paste the image into a word 

processing doc or a presentation slide. presenta-

tion slide. The techniques for capturing and 

pasting were described in my article series about 

screen capture techniques published in the 

PATACS Posts newsletter in 2018 and 2019. 
Included were capture techniques for Windows 

computers, Android smart phones and tablets, 

and iPhones and iPads. See the addendum below 

for PATACS Posts publication dates, and the 

web pages where you can find the newsletter 

issues, so you can retrieve the newsletter issues 

online and read those articles. 

capture screenimages to document the precise 

error messages shown to us by a computer or 

phone or tablet, and document what we did to 

make the error appear. I did not think of that use 

when writing the screen capture article series. 

Nonetheless, it works and we can all take advantage 

of it. How many times have you asked for help on 

some particular error message or puzzling software 

behavior, only to find out that the helper needs 

more info than you are able to recall? You may 

have not remembered or retained the exact error 

message, or the precise way you caused it to appear. 

It is a very common, even widespread experience. It 

has happened to me quite often with web pages. 

Sometimes the web servers suffer some sort of tem-

porary insanity, and fail to respond when I click on 

a link. Usually the solution is to wait it out. The 

web servers usually recover within ten to thirty 

minutes. 

JUNE MEETING: Google MUCH More Than Search  
*************************************************************

In this highly interactive session, Andy Living-
ston guides us to learn and do better all things that 
are Google such as Gmail, search tips, organize 
photos w/ Google photos, creating google docs, 
creating a personalized/shared calendar, make free 
phone calls w/ Google voice, learn about Google 
docs, download books, apps, music & more from 
the Google play store, utilize google keep to take 
notes, google translate to over 50 languages and 
much more.     
                                                  
ADDENDUM: With over 25 years of sales, busi-

ness development, marketing and technical experi-

ence in the commercial, government and a  variety 

of vertical markets, commercial, government and 

a  variety of vertical markets, LAD Communica-

tions   

-tions & Technology was started with the spirit 
of melding electronic  marketing with the latest 
in technolgy  support, training and curriculum 
development. 
 

Certifications: 
Í DCJS Certified (Department of Justice - 
electronic security) 
Í Dept. of Defense Secret Clearance 
Í Hewlett Packard University certified & 
trained (desktop/network) 

Í Sonitrol Security University trained & certi-
fied (security system design)  

Í AT&T Wireless Management Training Pro-
gram 

Í CompTIA A+ certification through FCPS 
ELearnIT program  

Continued Page 3 

June 15th - PC Clinic / in the Annex 

- Computer Got the Blues? 

Read the revised PC Clinic guidelines at                              

https://www.patacs.org/clinicpat.html 

to schedule help for your computer. 

http://patacs.org/clinicpat.html
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Ideally, when you do encounter an error, try to 

make that same error or puzzling behavior hap-

pen again, make a screen capture of each step of 

the process leading up to the error, and paste all 

of those screen captures into the same word pro-

cessing doc or presentation slide deck.  

For screen captures on phones and tablets, the 

screen images are automatically saved as photo 

files on the device. You can transfer the photo 

files to a computer, and then paste them all into a 

slide deck or word processing document for 

printing. Finally, save that slide deck or docu-

ment. 

HOW TO EXPLAIN THE ERROR IN DETAIL 

When you ask for help, either by email or over 

the phone or at a PATACS meeting the phone, or 

have the photos handy so you can easily explain 

both the precise error message and the process 

which led to that error message. At PATACS 

meetings, the best prep is to print the slide deck 

or document and bring the printed info with you. 

In email, you can attach the slide deck or docu-

ment. If you are participating remotely via Zoom, 

you can use Zoom to show the document to the 

meeting participants. 

SPEEDING UP THE ANSWER PROCESS 

You may find that the helpers, after seeing those 

screen captures, can understand the problem 

completely and provide solutions immediately. 

At the very least, showing the exact error mes-

sage will enable the helpers to ask you some spe-

cific questions. That too means the total time un-

til you get a useful answer may be reduced quite 

a bit.  

In this day and age, help desks for publishers of 

commercial operating systems and software are 

seldom considered a profit center, so the human 

resources are often stretched thin. Your request 

for help may go into a queue of requests for help, 

or you may call at a time when nobody is availa-

ble due to lack of 24/7 coverage. This screen cap-

ture approach definitely cannot overcome such 

structural compromises.  

However, when your own problem reaches the 

front of the queue, and you are contacted by the 

help desk staff, then you can provide those screen 

captures. Not only will your own recollection of 

the problem details be refreshed, but you will still 

be at least a few steps ahead of the average help-

seeker when it comes to getting answers. 

SOME QUESTIONS DEFY EASY ANSWERS-

Starting in the mid-1980s at meetings of the Wash-

ington Area Computer User Group (WAC), we had 

an initial general meeting and then used separate 

classrooms for Special Interest Group (SIG) meet-

ings. We had separate SIGs for Commodore Ami-

ga, Commodore 64/128, and MS-DOS, as I recall. 

At one point during the Amiga computer era, one 

person asked the following question at a WAC 

Amiga SIG meeting:   

How do you turn it off? 

Initially, I misunderstood the help-seeker's mean-

ing. I thought he wanted to know how to tell the 

computer to shut down. After a bit of conversation 

with him, I figured out that the shutdown method 

was not what he wanted. What he really meant was 

this: the computer is fascinating. How do I tear 

myself away? What he really meant was this: the 

computer is fascinating. How do I tear myself 

away? This happened log before the Web was in-

vented and so many people became addicted it. No 

surprise to me though. I have felt the same way 

ever since I learned to write computer programs in 

high school in 1968, using a teletype printer termi-

nal with paper punch tape for software storage. 

The computer was a mainframe, miles away and 

unseen. 

I will mention that Amiga provided a full color 

display (4,096 colors!) and multitasking, all of 

which made Amiga games, music composition 

software, and especially ray-tracing animation 

software extremely addictive. That was in an era 

when the first generation Mac was monochrome 

and task switching, and Windows was task-

switching and mostly provided no more than 256 

colors, and the first generation of dial-up computer  
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Stellarium ï A Home Planetarium                                                                                          
By Dick Maybach, Member, Brookdale Computer User Group, NJ 

www.bcug.com 

 

 

 

 

¶ Over 600,000 stars from the Hipparcos 
Catalogue and the Tycho-2 Catalogue, with 
extra catalogues available containing more 
than 210 million stars 

¶  Illustrations of the constellations, from the 
Western and other cultures                              

¶   Images of nebulae (full Messier catalog) 

¶  Realistic Milky Way 

¶  Realistic atmosphere, sunrise and sunset 

¶ Planets of the solar system and their major moons 

¶ Ability to display stars and other celestial objects 
as seen from reference points other than the 
Earth 

Advancing the time past sunset, results in the 
more satisfactory view of Figure 2, where the 
field of view has also been increased to show 
more of the sky. By default, only the major 
objects are labeled. (The two objects labeled 
ñAquariidsò are meteor showers.) (See at left.) 

You move around the sky with the mouse and zoom with 
the mouse wheel (or the Page-up and Page-down keys). Be-
cause your PC screen is flat and relatively small, you will 
probably display only a portion of the sky. (Stellariumôs de-
fault is to show approximately what appears in your normal 
field of view.) However, you can zoom back to see every-
thing above the horizon, as shown in Figure 2. 

Figure 2. Full Sky View. 

Figure 1. Stellarium Day View 

 

This free software for Windows, Linux, and OS X (http://stellarium.org/) turns your PC or Raspber-

ry Pi into a planetarium to display the stars in the sky, the constellations, and individual and groups 

of stellar objects. There is a Web-based version you can access with a browser (at http://stellarium-

web.org/), and variants are available for cell phones (usually for a small cost). Available on the 

networks were less than a decade old. Ancient history, but an instructive experience. Some questions 

defy easy answers. 

ADDENDUM:   PATACS Posts published the screen capture article series:                                                                    

ÅWindows: October 2018 and November 22018 Åwww.patacs.org/nlposts/1710posts.pdf and 

www.patacs.orgnlposts/1711posts.pdf                     ÅAndroid  phones and tablets: 

Åwww.patacs.orgnlposts/1712posts.pdfiPhones and iPads: January 2019www.patacs.org/

nlposts/1801posts.pdf                                                    About the author: John Krout is a past presi-

dent of the Washington Area Computer User Group (WAC, a predecessor of PATACS, and the found-

er of WAC Amiga SIG., is a frequent contributor to PATACS Posts and occasionally provides demos 

and educational presentations at PATACS / OLLI OPCUG joint meetings in Fairfax City VA.                       

http://stellarium.org/
http://stellarium-web.org/
http://stellarium-web.org/
file:///C:/Users/Kathy/Documents/patacs%20nl/all%20nl/0-19-6%20nl/www.patacs.org/nlposts/1710posts.pdf
file:///C:/Users/Kathy/Documents/patacs%20nl/all%20nl/0-19-6%20nl/www.patacs.org/nlposts/1712posts.pdf
file:///C:/Users/Kathy/Documents/patacs%20nl/all%20nl/0-19-6%20nl/www.patacs.org/nlposts/1801posts.pdf
file:///C:/Users/Kathy/Documents/patacs%20nl/all%20nl/0-19-6%20nl/www.patacs.org/nlposts/1801posts.pdf
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Figure 5.  Saturn 

  

 

 

 

 

 

 

 

 

 

 

 

 

You can add the constellations 
as lines connecting their starts 
as shown in Figure 4, and you 
can also see their artwork as in 
Figure 5. The constellations and 
artwork shown are those used in 
the western world, which are 
the defaults. The program can 
instead display the constella-
tions of many other cultures. 

Figure 3. . Constellation Art (Western Traditional). 

Figure 4. Information Displayed About Polaris. 

Selecting an object dis-
plays information about it; 
Figure 4 shown this for 
Polaris. Most users will 
configure the program to 
show fewer data, as much 
of what is shown here will 
interest only astronomy 
enthusiasts. 

You can zoom in to view 
individual objects, such a 
Saturn in Figure 5. By 
default, Stellarium shows 
the sky in real time, and 
at high magnifications 
individual objects will 
rapidly move off the 
screen, but you can cor-
rect this by stopping its 
clock.   
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Figure 6. Night Mode. 

If you have Stellarium 
on a laptop or other 
mobile device, you can 
use it outside to help 
you identify features in 
the actual sky. In this 
case, youôll want to 
use Night Mode, 
which displays every-
thing in red to preserve 
your night vision; see 
Figure 6. 

In addition to the visible stars and planets, Stellarium can also show artificial satellites and deep sky 
objects (DSOs). The term is used for the most part by amateur astronomers to denote faint objects 
such as star clusters, nebulae, and galaxies. It can also show exoplanets (planets that orbit other stars 
than our sun). As Figure 9 shows, if you display both satellites and deep sky objects, the screen be-
comes quite cluttered. Especially, since the satellites except those in synchronous orbits are in rapid 
motion. (In the figure, the synchronous satellites appear in an arc about one-third down from the top.) 

Folks now know far less 
about our night sky than 
in the past, when nights 
were darker and the stars 
more visible, and we also 
tend to spend our nights 
indoors. Most of us can 
identify only the big and 
little dipper constella-
tions. Stellarium offers 
you a way to expand 
your knowledge without 
even leaving your chair, 
although stepping outside 
on a clear night to look at 
the actual sky is always 
rewarding. 

Figure 7. Satellites and Deep Sky Objects. 
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Solution: To find the version of your Windows 
operating system, type in the Search box at the 
bottom left of the taskbar the word winver. 
Then click the winver run command to see 
your computerôs details. 
 
4. Sometimes you forget what version of Win-
dows you have on your computer. ñVersionò 
includes the operating system (Windows 7, 
8.1, or 10) and the Windows update version 
number, such as the recent update, 1803. But 
youôre not sure how to find the answer. 

 
Solution: To find the version of your Windows 
operating system, type in the Search box at the 
bottom left of the taskbar the word winver. 
Then click the winver run command to see 
your computerôs details. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

5 . When you enter an email or web address 
in a document, by default Word automatically 
adds a hyperlink to the address. You can 
identify a hyperlink by its blue text and under-
line. Many times, you donôt want the hyperlink 
included. 
Solution: There is a way to change the setting 
to stop the automatic hyperlink from being 
added. Click the File tab (top left of the rib-
bon), then click Options (last item on the 
menu). Click Proofing > AutoCorrect options > 
Autoformat and uncheck the last item on the 
Replace list, ñInternet and network paths with 
hyperlinks,ò then click OK.   
 

1. You print a multi-page Word document and get 
an unexpected blank page at the end of the docu-
ment. Because it has a footer, you wonôt be able 
to use that sheet for anything except scrap paper. 

 
Solution: Before you click  Print, press the 
Show/Hide key on the Home tab > Para-
graph group and scroll or press the 

Ctrl+End keys to get to the end of the document. 
You will see one or more paragraph icons on the 
last blank page.  Select them and press Delete. 
Then save the document to avoid the blank page 
in future printings.1. 
 
2. You open a document and find you have to 

squint to see the 
small type.  
Solution: Go to the 

Zoom slider at the bottom right of the screen and 
click the + sign a few times until the document 
text is large enough to be comfortable for your 
eyes. This will not affect the text size when print-
ed. 
 
3. You are just about done typing a Word docu-

ment and notice that all 
the text in the last cou-
ple of sentences is in 
upper case. You had 
pressed the Caps Lock 
key on the keyboard 
accidentally.  
 
Solution: First select the 
text you want to refor-
mat. Then click the 

Change Case tool (Aa) on the Home tab > Font 
group. Click the case pattern you want from the 
list, which in this situation is probably ñSentence 
case.ò  
 
Sometimes you forget what version of Windows 
you have on your computer. ñVersionò includes 
the operating system (Windows 7, 8.1, or 10) and 
the Windows update version number, such as the 
recent update, 1803. But youôre not sure how to 
find the answer. 

 
 

Continued Page 8 

Six Little Word Problems and their Solutions 
By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL                             

STUG Monitor        www.thestug.org / ndemarte (at) verizon.net 
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document, by default Word automatically adds a 
hyperlink to the address. You can identify a hy-
perlink by its blue text and underline. Many 
times, you donôt want the hyperlink included. 
 
Solution: There is a way to change the setting to 
stop the automatic hyperlink from being added.  
Click the File tab (top left of the ribbon), then 
click Options (last item on the menu). Click 

Proofing > AutoCorrect options > Au-
toformat and uncheck the last item on 
the Replace list, ñInternet and network 

paths with hyperlinks,ò then click OK.   
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operating system, type in the Search box at the 
bottom left of the taskbar the word winver. Then 
click the winver run command to see your com-
puterôs details. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 

 
 

Just to be safe, also click ñAuto 
Format As You Typeò and uncheck 
the same box there, followed by 
OK. While you are in the Word 
AutoCorrect area, check to see if 
you are being bothered by any oth-
er automatic action. If so, uncheck 
it and click OK. While you are in 
the Word AutoCorrect area, check 
to see if you are being bothered by 
any other automatic action. If so, 
uncheck it and click OK. If you 
change your mind, return to this 
screen and re-check the boxes. 

6. You have typed a long list of items, such as book titles, taking up several pages of a 
Word document. Each title is on a separate line. You would like to find out how many 
items there are in the list, but counting them would be tedious. 
 
Solution: Select the entire list using Ctrl+A. Then on the Home tab - Paragraph group, 
click the numbering tool (top row, second from left) to place a number in front of each 
item. Then press Ctrl+End to jump to the end of the list, where you can view the last num-
ber. If you wish, then press Ctrl+Z or Undo to remove the numbering. 
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At a recent NNCUG meeting, Susan showed 
and explained an SD card reader that she uses. 

A memory card reader is 
a device that can read 
flash memory cards and 
transfer their contents to 
a computer. Flash 

memory cards come in various types and for-
mats, providing removable storage for digital 
equipment like camcorders, cameras, MP3 play-
ers and cell phones. There are single and multi-
ple card readers, and while the former can only 
read a single memory card type, the latter can 
read a variety of formats. 

Without a memory card reader, a person has to 
directly connect the physical device that uses 
memory cards to the computer. This is usually 
done with a Universal Serial Bus (USB) or Fire-
wire cable. The advantage of a 
reader is that memory cards 
can be read directly on the 
computer without attaching 
the device. This greatly sim-
plifies using, storing and organizing the cards. It 
also saves batteries and wear and tear on the 
camcorder or other digital device. 

It is common for people to own more than one 
device that uses flash memory cards, with each 
device using a different type of card. A multiple 
card reader will accept a variety of formats, 
making it useful for all of your memory card 
needs. These readers commonly feature two or 
more slots to accept different sized cards. Some 
memory card readers are extremely compact, 
barely larger than the cards they read. These 
plug directly into the USB port and are about 
the size of a memory stick. Others are designed  

 

to be internally installed into a free bay on 
desktop computers, with an array of choices 
between these two models. One advantage of 
the external model is that it is portable, able to 
be used with multiple computers and/or lap-
tops in the household.  

Many newer computers, including many lap-
tops and notebooks, have a card reader built-in 
by default. Printers and even some monitors 
may have them as well, so that the information 
on the cards can easily be printed or displayed. 
Anyone who has been thinking about replacing 
an aging desktop, laptop, printer or monitor, 
might look into these options first.  

When buying a reader, consumers should be 
sure it supports the type of card(s) required. 
This includes the 
card's capacity in addi-
tion to the format. 
Some models might 
not read flash memory 
cards larger than 1 
GB, for example. 
Shoppers should also 
bear in mind too that a 
more flexible card reader that supports addi-
tional formats might make the device a little 
more future proof in the event that hey acquire 
more digital devices later or replace the ones 
they already own.  

Memory card readers are typically extremely 
affordable, and they can be found at many 
online retailers and local suppliers of comput-
ers and digital equipment.  

To see a video on SD card readers, click on 
the link. https://binged.it/2C6fUDg  

 

SD Card Readers 

Review of presentation  by Susan Malloy, Secretary,                                                      
Northern Neck Computer User Group, NY                                                                      

Review by George Cadmus  The Computer Link                                    
www.nncug.org              geocadjr (at) verizon.net 

https://binged.it/2C6fUDg
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Kretchmarôs Korner  

How to Connect a Laptop PC or a                            
Tablet to an iPhone Personal Hotspot 

By David Kretchmar,                                                  
Computer Hardware Technician,                                                                       

Sun City Summerlin Computer Club, NV               
The Gigabyte Gazette                                

www.scscc.club     tomburt89134 (at) cox.net 

Most smart cellphones can connect to the Internet 
whereever they can find a 3G or 4G signal, but 
most PCs and tablets need a Wi-Fi connection to 
get online. Some tablets do have 3G and 4G con-
nectivity, but those cost extra and aren't that com-
mon.  

As a result, users with smartphones can usually 
get online in places other device users are stuck 
offline.  

This article discusses a technique for using your 
iPhone as a personal hotspot, allowing your PC to 
connect to the Internet. My personal experience 
relates specifically to the iPhone, but similar tech-
niques are applicable to most other 3G or 4G An-
droid cell phones.  

I only have an iPhone to play with, and a Win-
dows 10 laptop PC to connect, so my experimen-
tation was limited to these devices. 

On the iPhone     

You need to set a Wi-Fi password in order to 
set up a Personal Hotspot. on your iPhone, if 
it's not on already. You can do this through Con-
trol Center or the Settings app.  

Choose a Wi-Fi password that's at least eight 
characters long and use ASCII characters. ASCII 
lowercase and uppercase and the digits 0 through 
9. Many punctuation marks are ASCII, but most 
people avoid them in passwords.  

Turn on Wi-Fi and Personal Hotspot on your 
iPhone, if it's not on already.  

You can do this through Control Center or the 
Settings app.  

Tap Settings  

Tap Wi-Fi  

Tap Personal Hotspot, and then tap the slide but-
ton to turn it on. Note that the password you estab-
lished now shows.  

If you don't see the option for Personal Hotspot, 
contact your carrier to make sure you can use Per-
sonal Hotspot with your plan. 

On the PC or other device you want to get 
online 

Click on the wireless icon; on a Windows 10 PC 
this will appear near the right side of the Taskbar. 
This will reveal the wireless networks available.  

In this example I saw the name I assigned to my 
iPhone, ñDavidôs iPhone.ò Click on your network 
and enter the network password. Itôs that easy!  

When you connect a device to your iPhone Per-
sonal Hotspot, the status bar turns blue and shows 
how many devices have joined.  

The number of devices that can join your Personal 
Hotspot at one time depends on your carrier and 
iPhone model.  

If other devices have joined your Personal Hotspot 
using Wi-Fi, you can use only cellular data to con-
nect to the Internet from the iPhone host.  

Naturally, cellular data usage and possible charges 
(if you exceed your plan limit) will apply when 
you use your iPhone to connect any device to the 
Internet. 


